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UNIT 1 

FUNDAMENTALS OF COMPUTER 

1.1 Review Brief history of computer 

 The history of computers starts about 2000 years ago in Babylonia (Mesopotamia), at the 

birth of the abacus and many devices were invented during different periods as listed in the 

table. 

Abacus 

Chinese invented a calculating device called 

ABACUS to perform simple addition and 

subtraction. 

    Abacus 

Napier’s Device 

John Napier invented a device consisting a set 

of eleven rods which carried numbers marked 

on them to perform products and quotients of 

large numbers. 

Slide Rule 

Robert  Bissoker invented Slide Rule in 1632, 

which can perform arithmetic and 

trigonometric functions. 

Pascal’s Calculating Machine (Pascaline) 

Blaise Pascal developed a mechanical 

calculating machine. It was the first real 

desktop calculating device. 

It consists of a set of toothed wheels on which 

digits were engraved form 0 to 9. Arithmetic 

operations were performed by turning the 

wheels. 

Punched card machine 

Joseph Marie Jacquard invented the first 

punched card machine to control textile 

looms. 

      Napier's Device 

        Slide rule 

        Pascal's Calculating Machine 

          Punched Card Machine 

http://en.wikipedia.org/wiki/Babylonia
http://en.wikipedia.org/wiki/Abacus
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Charles babbage’s Engines (1792-1871) 

Charles Babbage invented Difference 

Engine, which could evaluate accurately 

algebric expressions and mathematical tasks 

upto 20 decimal places. 

The modified device was called Analytical 

Engine. It was an automatic computing 

machine. 

The parts and principle of Analytical engine is 

similar to today’s computer. Hence, Charles 

Babbage is called the “Father of Computer”. 

Mark-I Digital Computer 

Howard Aiken invented the first electro-

mechanical computer in 1937. It used the 

punched cards and the principles of computer 

as stated by Charles Babbage. It could 

multiply two 20 digit numbers within 5 

seconds. Made lot of noise. Occupied several 

rooms. 

Atanasoff Berry Computer (ABC) 

The First Electronic Computer (ABC) was 

developed by John Vincent Atanasoff and 

Clifford Berry. This used Vacuum  Tubes for 

storage, arithmetic and logical functions. It 

could perform 5000 additions and 350 

multiplications in 1 second. 

ENIAC (Electronic Numerical Integrator 

and Calculator) 

Presper Eckert and John Mauchly developed it 

in 1940. It used 18,000 vacuum tubes, 70,000 

resisters, 10,000 capacitors and 60,000 

switches weighted 27 tons and occupied over 

5,000 square feet of space. It consumed 150 

KW of power. 

EDVAC (Electronic Discrete Variable 

Automatic Computer) 

The first stored program electronic computer 

was developed in 1949 using Neumann’s idea 

of stored program concept. 

              Charles babbage's Engine 

              Analytical Engine 

           Mark-I Digital Computer 

                Atanasoff Berry Computer 

        ENIAC 

        EDVAC 

AEES



VI-STD ATOMIC ENERGY EDUCATION SOCIETY 3 

UNIVAC (Universal Automatic Computer) 

It was developed by Eckert and Mauchly 

during 1946 to 1951. 

It was the first commercially available 

computer.  

Microprocessor 

The first micro processor chip INTEL 4004 

was developed in 1971 by INTEL 

Corporation. It laid the foundation for the 

development of Personal Computer. 

Personal computers 

The first personal computer was developed in 

1974. 

           Personal computer 

1.2 Basic components of computer 

 There are three major units of Computer.

1. Input Unit

2. Central Processing Unit (CPU)

3. Output Unit

Figure 1.1: Components of computer 

            UNIVAC 

        INTEL 4004 
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# Input Unit 

 Input Unit accepts the input data from the user via input devices such as Keyboard,

Mouse.

 Other input devices will be discussed in chapter 1.3.

# Central Processing Unit 

CPU consists of three subsystems, 

1. Memory Unit

2. Control Unit

3. Arithmetic and Logical Unit

# Memory Unit 

 Memory Unit stores the data and information.

 Basic unit of memory is bit.

 A bit can hold only one of two values: 0 or 1.

 Units derived from bits are,

1 bit = Binary Digit (0 or 1) 

8 bits = 1 byte 

1024 bytes = 1 KB (Kilo byte) 

1024 KB = 1 MB (Mega byte) 

1024 MB = 1 GB (Giga byte) 

1024 GB = 1 TB (Terra byte) 

1024 TB = 1 PB (Peta byte) 

There are different types of Memory that will be discussed in chapter 1.6. 

# Control Unit 

 Control unit generates signals that direct the operation of memory and datapath.

 The control signals, instructs the memory to send or receive data, instructs the ALU

about the operations to perform and route data between parts of the datapath.

# Arithmetic and Logical Unit 

 ALU performs arithmetic operations such as addition, subtraction, multiplication

and division.
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 It also performs logical operations such as AND, OR, NOT.

# Output Unit 

 Output unit is used to display the output via output devices such as monitor,

projector.

 Other output devices will be discussed in chapter 1.3.

1.3 Different I/O Devices 

# Input Devices 

 Input devices are used to get data and instructions from the user.

 These devices convert data and instructions to a form that can be recognized by

the computer (ie, binary language)

# Types of Input devices 

 Keyboard

 Mouse

 Scanner

 Joystick

 Digital Camera

Figure 1.2 : Input Devices 
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# Keyboard 

 Keyboard is the most commonly uesd input device. Used to enter data and

instructions.

 It converts keystrokes into electrical signals that a computer can understand.

 Types of keyboard are

o Standard keyboard

o Multimedia keyboard

o Wireless keyboard

# Mouse 

 Mouse is the most popular point-and-draw device.

 Types of mouse

o Mechanical mouse

o Optical mouse

# Scanner 

A scanner is an electronic device which can capture from physical items and convert them 

into digital formats, which in turn can be stored in a computer. 

 Common scanner devices are,

o MICR (Magnetic Ink Character Recognition) : Used by banks to find the

genuinity of the cheques.

o OMR (Optical Mark Reader) scanner: Used to evaluate OMR sheets.

o OCR (Optical Character Recognition) scanner: Used to read printed

characters from the hard copy  and convert into softcopy.

o Barcode reader : Used to read the barcode of the products and get the details

about  it in the stores.

o QR Code (Quick Response Code): It is an advanced version of Barcode

designed in 1994. It consists of black squares arranged in a square grid on a

white background, which can be read by an imaging device. QR code can be

scanned using a smartphone, no need of any specific device. It can be scanned

from any direction. Due to the extremely fast scanning facility, it is now

widely used to get to websites quicker and it can also be used for

advertisements.
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# Joystick 

 Used to control player movements in the video games.

# Digital cameras 

 Used to create image of an object in digital form that can be stored and interpreted by

the computer.

# Output Devices 

Output devices are used to display the output or to take hardcopy of the output. 

# Types of output devices 

 Monitor

 Printer

 Plotter

 Projector

 Speakers

# Monitor 

 Monitors are used to display the output.

 Types of Monitor

o CRT (Cathod Ray Tube) Monitor

o LCD (Liquid Crystal Display) Monitor

# Printer 

 Printers are used to produce hard copy (print on paper) of the documents or images.

 Types of printers will be discussed in chapter 1.7.

# Plotter 

 Plotters are like printers but used to print graphic output of varying size.

 Used to print Blue print , Maps.

# Projector 

 Used to project information from a computer on a large screen.

# Speakers 

 Speakers are used to listen audio files.
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Computer 
Languages 

Low level 
Language 

Machine 
Language 

Assembly 
Language 

High level 
Language 

 1.4 Computer Languages 

A Computer language includes various languages that are used to communicate with a 

Computer machine. A Computer can understand only binary language. 

 # Types of Computer Language 

 Low level language

 High level Language

Figure 1.3: Types of Computer Languages 

# Low level Language 

 Low level languages are the machine codes in which the instructions are given in

machine language in the form of 0 and 1 to a Computer system.

 Low level languages are divided into two types

o Machine language

o Assembly language

# Machine language 

 Machine language is written in machine code which represents 0 and 1 binary digits

inside the Computer string which makes it easy to understand and perform the

operations.

 An advantage of using Machine language is that there is no need of a translator or an

interpreter to translate the code, as the Computer directly can understand.
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 Disadvantages of using Machine language is that it is difficult to remember the

operation codes, memory address and also hard to find errors in a written program. It

is machine dependent.

# Assembly Language 

 Assembly Languages are written using Mnemonic codes.

 A mnemonic is a symbolic name for a single executable machine language

instruction (an opcode) and there is at least one opcode mnemonic defined for

each machine language.

 An assembler is used to convert assembly level language into machine level

language.

# High level Language 

 High level languages look similar to the English language, and hence are better

understood by the programmers.

 The translator may be an interpreter and Compiler, helps to convert high level

language into binary code for a Computer to understand.

 There are various high level programming languages like FORTRAN , COBOL

and Pascal.

1.5 Software definition and its types 

# Software 

A set of programs to perform a particular task is called Software. 

There are two types of Software 

1. System Software

2. Application Software

System Software 

A set of program used to control and co-ordinate the computer system is called System 

software.  For example Operating System, Device Drivers , System Utilities, etc., 

 Device drivers

o A device driver is a system software developed to allow interaction with hardware

devices. This acts as an interface for communicating with the device, connected to

the CPU.

AEES
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 System Utilities

o Utility software is system software used to analyze, configure, optimize or

maintain a computer. Examples for system utilities are Anti-Virus, Backup

software, Disk Cleaners and Disk Formatters.

o Anti-virus utilities scan for computer viruses and remove them.

o Backup software makes copies of all information stored on a disk and

restores either the entire disk (e.g. in an event of disk failure) or selected files

(e.g. in an event of accidental deletion).

o Disk cleaners find files that are unnecessary to computer operation, or take up

considerable amounts of space. Disk cleaner helps the user to decide what

to delete when their hard disk is full.

o Disk formatters prepares a data storage device such as a hard disk drive,

solid-state drive, floppy disk or USB flash drive for initial use.

 Operating System

An operating system (OS) is a system software that manages computer 

hardware and software resources and provides common services for computer programs. 

    Functions of Operating System 

o Booting: Booting is a process of starting the computer operating system. It starts

the computer to work. It checks the computer and makes it ready to work.

o Memory Management : In multiprogramming, the OS allocates memory to the

individual process as required

o Disk Management : Operating system manages the disk space. It manages the

stored files and folders in a proper way.

o Process Management : CPU can perform one task at one time. If there are many

tasks, operating system decides which task should get the CPU.

o Printing controlling: Operating system also controls printing function. If a user

issues two print commands at a time, it does not mix data of these files but prints

them separately.

 # Application Software 

A set of programs to satisfy the user needs are called Application Software. 

 Functions of application software

o Managing information

o Manipulating data

o Constructing visuals

o Coordinating resources

o Calculating figures

AEES

https://en.wikipedia.org/wiki/System_software
https://en.wikipedia.org/wiki/Anti-virus
https://en.wikipedia.org/wiki/Backup_software
https://en.wikipedia.org/wiki/Hard_disk_failure
https://en.wikipedia.org/wiki/Disk_cleaner
https://en.wikipedia.org/wiki/User_(computing)
https://en.wikipedia.org/wiki/File_deletion
https://en.wikipedia.org/wiki/Disk_formatting
https://en.wikipedia.org/wiki/System_software
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Computer_software
https://en.wikipedia.org/wiki/Daemon_(computing)
https://en.wikipedia.org/wiki/Computer_program


VI-STD ATOMIC ENERGY EDUCATION SOCIETY 11 

Types of Application Software 

Word Procerssor, Spread sheet, Presentation software, Database Management System 

(DBMS), Image editing software are different types of Application software. 

Word Processor: A word processor is an application software that performs the task of 

composing, editing, formatting, and printing of documents. 

Examples for word processor are Microsoft Office Word, Word perfect and OpenOffice.Org 

Writer. 

Spread sheet: It is an application software for organization, analysis and storage 

of data in tabular form. Examples for Spread sheet software are Microsoft Excel, Lotus123. 

Presentation software: A presentation program is a software package used to display 

information in the form of a slide show.  Examples are Microsoft Powerpoint, Softmaker 

presentation etc., 

DBMS:  It allows the definition, creation, querying, update, and administration of databases. 

Examples are Microsoft access, SQL (Structured Query Language). 

Image editing software: It is used to edit the digital  photo. Examples are Adobe photoshop, 

GIMP. 

1.6 Computer Memory 

Computer memory is used to store data and programs. 

# Types of Computer memory 

There are two types of memory 

1. Primary memory

2. Secondary memory

 Primary memory

Primary memory is also known as main memory. 

There are two types of primary memory 

1. RAM (Random Access Memory)

2. ROM (Read Only Memory)
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Computer 
Memory 

Primary 
Memory 

RAM ROM 

Secondary 
Memory 

# Random Access Memory: It is a temporary memory. The data stored on RAM will be 

erased when the power goes switched off. So it is also called as Volatile memory. 

 Types of RAM

o SRAM - Static Random Access Memory.

o DRAM - Dynamic RAM.

o SDRAM- Synchoronous Dynamic RAM

o DDR- Double Data Rate SDRAM

# Read Only Memory: The memory from which we can only read but cannot write on it. 

The information is stored permanently in such memories during manufacture. It cannot be 

deleted by the user. So it is also called as non-volatile. 

A ROM stores such instructions that are required to start a computer. This operation is 

referred to as bootstrap. 

AEESFigure 1.4: Types of Computer Memory 
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Types of ROM 

 PROM (Programmable Read Only Memory)

 EPROM (Erasable and Programmable Read Only Memory)

 EEPROM (Electrically Erasable and Programmable Read Only Memory)

 Secondary memory

It is mainly used for storing information on permanent basic. It is slower than primary 

memory. Example: Hard disk. 

1.7 Different types of Printer 

Printers are divided into two categories 

1. Impact printers

2. Non-Impact Printers

# Impact printers 

An impact printer makes contact with the paper. It usually forms the print image by pressing 

an inked ribbon against the paper using a hammer or pins. 

Examples of impact printers are Dot-Matrix Printer, Daisy wheel Printer, Line Printer, Drum 

Printer. 

 The Dot-Matrix Printers

o matrix printer uses print heads containing from 9 to 24 pins.

o These pins produce patterns of dots on the paper to form the individual characters.

o The 24 pin dot-matrix printer produces better quality print.

o Printing speed is 100-600 characters per second.

Advantage 

o Inexpensive.

 Daisy-wheel printers

o In Daisy wheel printer the print mechanism looks like a daisy; at the end of each

“Petal” is a fully formed character which produces solid-line print.

o A hammer strikes a “petal” containing a character against the ribbon, and the

character prints on the paper.

o Printing speed is slow typically 25-55 characters per second.

# Non-impact printers 

 Non-impact printers do not use a striking device to produce characters on the paper;

and because these printers do not hammer against the paper.

Examples of non-impacted printers are Ink-jet printer, Laser Printer.
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 Ink-jet printers

o Ink-jet printers form characters on paper by spraying ink from tiny nozzles

through an electrical field that arranges the charged ink particles into characters.

o The ink is absorbed into the paper and dries instantly.

o Various colors of ink can also be used.

o Printing speed is approximately 250 characters per second.

Advantages of Ink-jet printer

o These printers produce less noise

o Print in better quality

o Greater speed.

Disadvantages of Ink-jet printer 

o The maintenance cost is high.

 Laser printers

o Laser printers produce images on paper by directing a laser beam at a mirror

which bounces the beam onto a drum.

o The drum has a special coating on it to which toner (an ink powder) sticks.

o Using patterns of small dots, a laser beam conveys information from the

computer to a positively charged drum to become neutralized.

o From all those areas of drum which become neutralized, the toner detaches. As the

paper rolls by the drum, the toner is transferred to the paper printing the letters or

other graphics on the paper. A hot roller bonds the toner to the paper.

Advantages of Laser Printer 

o The main advantage of Laser printer is its speed & efficiency at which it prints

high-quality quality graphics & text.

o Laser printers does not produce disturbing sounds.

 Disadvantages of Laser Printer 

o Cost is relatively high when compared to other printers.AEES
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EXERCISES 

I. Fill in the blanks:

1) Speaker is an ___________________ device.

2) Primary memory is also known as 'Main Memory' and Seconday memory is also

known as ______________________ memory. 

3) Keyboard converts the keystrokes into ____________________________ that a

computer can understand. 

4) CPU stands for ___________________________________.

5) ________________________ works as both input device as well as output device.

(Touch screen / Mouse ). 

II. State True of False

1) Computer can understand only the language of 1's and 0's.

2) Generally capacity of Primary memory is bigger than the capacity of Secondary

memory.

3) Optical devices work based on the principals of light.

4) When there is no power supply all the contents of ROM will be erased.

5) AND, OR , NOT are arithmetic operations.

III. Memory conversions

1) 4 KB = _________ bits.

2) 200 MB = ___________ KB.

3) 1B= ______ b.

4) 2 TB = _________ GB.

5) ________ MB = 5 GB.
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IV. Short answer type questions

1) Name any four input and four output device.

2) Draw a neat diagram of different components of computer and show how they are 

connected to each other.

3) Define Software. What are the different types of software?

4) What is a device driver?

5) What is the difference between software and hardware?

6) What is the difference between Primary memory and Secondary memory?

7) What is the difference between System software and Application software? 

ACTIVITIES 

1. Showing an Input device and an Output device.

2. Showing RAM and ROM.
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UNIT II 

WORD PROCESSING (MS WORD) 

2.1 Header and Footer 

The content in the Header will appear at the top of each page of the document. The content in 

the Footer will appear at the bottom of each page of the document.  

# Steps to include Header 

 Click on Insert menu.

 Click on Header option in the Header & Footer group.

 The build-In options appear as shown below,

 Select the desired option

 Type text tag will appear on the window. Type the content to appear in the header.

 Click on Close header and footer option in the close group.

 The typed text will appear on the top of each page of the document.

# Steps to include Footer 

 Click on Insert menu.

 Click on Footer option in the Header & Footer group.

 The build-in options appear.

 Select the desired option.

 Type text tag will appear on the window. Type the content to appear in the footer.

 Click on Close header and footer option in the close group.

 The typed text will appear on the bottom of each page of the document. 
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2.2 Formatting of Paragraph 

# Steps to Format paragraph 

 Formatting a paragraph allows you to change line spacing, indent lines and paragraph. 

The tools in the Paragraph group of Page Layout menu are used to format the Paragraph. 

Changing Paragraph Alignment 

Paragraph alignment allows the text to be aligned center, left, right, or justify (which means 

aligning it between both the right and left margins). 

# Steps to Change Paragraph Alignment 

 Select the paragraph to be aligned.

 Click on Home menu.

 Tools for alignment appears as shown below, 

 Click on the required alignment tool.

Indenting Paragraphs 

Indenting paragraphs allows to set different margins for different lines of text. 

# Steps to indent paragraph 

 Keep the cursor before the line for which indent has to be increased or decreased.

 Click on the Home menu

 Select the indent buttons in the 'Paragraph' group.
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 A click on the respective tool will allow the text to indent left or right. The indention

increases each time you click on the button.

Alternative method 

Keep the cursor before the line for which indent has to be increased or decreased. 

Right click and choose paragraph option. 

Paragraph dialog box appears as shown below, 

 Click the Indents and Spacing tab.

 Set the indentions.

 Click on Ok button.

Add Borderss or Shading to a Paragraph 

Borders and shadings can be added to a paragraph, many paragraphs or to an entire page. 

# Steps to add borders and shadings to a Paragraph 

 Select the paragraph to which border and shading has to be applied.

 Click on the border button in the paragraph group.

 A dropdown menu of borders option will appear.

 Click on the Borders and shadings option

 The Borders and Shading dialog box appears as shown below,
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 Choose the border pattern and click on OK.

 Click on the Shading tab.

 The following window appears,

 Choose the desired color for shading.

 Click on OK button.

Apply Paragraph Styles 

 Style refers to the format of the paragraph.

 MS Word offers several built-in styles.

 These include headings, no spacing, subtitles, emphasized text, list paragraph, etc.

# Steps to apply style to a paragraph 

 Click on 'Home' tab

 Many styles appear as shown below in the Styles group.

 Scroll through these styles to find the suitable one.

 Click on the selected style.
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2.3 Mail Merge 

It is an advanced feature of MS Word, which allows to generate any number of letters in 

which some content of the letter being different and major content remains the same.   

For example,  to send a birthday invitation to many people, the content remains the same, 

only the recipient address will be different in each letter.  

So any number of invitations can be prepared from a main document and the data source. 

This can be achieved with the help of mail merge. 

# Steps for Mailmerge 

There are 3 major steps, 

1. Creating the Main document

2. Creating the Data source

3. Merging the field

1. Creating a Main document

#  Steps to Create the Main document prepare 

 Open a new document in MS Word.

 Type the complete body of the letter. Leave sufficient space where the recipient

address has to be included.

 Format the letter.

 Save the file.
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            Screen shot of a main document 

 Click on Start Mail Merge command in the Start Mail merge

group in the Mailings tab.

 Click on letters in the appearing drop down menu.

2. Creating the Data source

# Steps to Create the Data Source 

 Click on Mailings tab

 Click on Select Recipients option in the Start Mail Merge group.

 Click on Type New List… option from the drop down menu.

 The New Address List dialog box appears as shown below,

 Click on Customise Columns button to select the field names to be included in the

Data source.

 The following Customise Address List dialog box will appear as shown below,
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 By default some fields are shown in the dialog box, Select the unwanted field name

and click on delete button.

 Click on Add button to add new fields

 After adding all the required fields, click on Ok button.

 The selected fields will appear as shown below,

 Type the entries in the first row.

 Click on New Entry button to add a new entry.

 After adding all the entries, click on Ok button.
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 A Save Address List dialog box will appear as shown below,

 Type the file name and Click on Save button.

 The data source will be saved automatically with .mdb extension.

3. Merging the field

# Steps to Merge the fields 

 Open the main document and keep the cursor where the field

has to be inserted.

 Click on Insert Merge Field command in the Write & Insert

Fields group.

 The field names available in the data source will appear in the

drop down list. Click the field to be merged with the main

document. The field will be inserted in the main document.

 To add more fields again repeat the previous step.

 The main document will appear as shown below,

 Click on Finish & Merge option in the Finish group.

 Click on Edit individual document to merge to a new document.
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 Click on Ok button.

The document will be merged and a new document will be created as shown below, 

By default the created document is named as Letters1. 

Save the document with the desired name. 
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Note : Our sample data source contains only 3 records, so 3 letters are prepared in a new document by 

the mail merge process. If ‘n’ number of records are entered,  then it will prepare ‘n’ such 

letters in a new document. 

2.4 Envelope and labels 

# Steps to create an envelope 

 Click on Mailings tab

 Click on the envelopes in the create group.

 Envelopes and labels dialog box will appears as shown below

. 

 In the Delivery Address, type the recipient address.

 In the Return address, type the address of the sender.

 Click on Options button, an envelope options window opens as shown belowAEES



VI-STD ATOMIC ENERGY EDUCATION SOCIETY 27 

 Select the envelope size by clicking on the drop down list.

 Delivery address and Return address font size can be edited by clicking on the font

button.

 Click on OK button.

 Address of sender and Receiver will be seen on the envelope.

 Preview before printing the envelope.

# Create labels 

 Click on Mailings tab

 Click on labels in the create group.

 In the address textbox, delivery address will appear by default. In case you want to 

create labels for return address, click on use return address check box.

 Click on options button and select the number of labels to be printed per page from 

the product number drop down list.

 Click on print button to print the labels 

 Click on New Document button to get the labels in a new document. A sample label

created with 30 labels in a page is displayed here.

2.5 Page column 

 Select the text for which the column format has to be changed. if you do not select

any text, Word will format the entire document.

 Click on the Page Layout tab

 Click on the Columns... in the Page Setup group

 Choose the format from the drop down list .
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 You can select a preset, automatically formatted number of columns with equal

spacing by clicking One, Two, Three, or Four.

 By clicking More columns.... option, number, width, and spacing of the columns can 

be customised. 

 Click on OK.

2.6 Hyperlink 

A hyperlink is a reference to data that the reader can directly follow either by clicking or 

tapping. 

# Steps to include Hyperlink 

 Select the text for which Hyperlink needs to be included.

 Click on Insert Tab

 Click on Hyperlink in the Links group

 Insert Hyperlink dialog box appears as shown below,

 Select the file to be linked and click on Ok button.

 Click on ScreenTip button, to display some text as a tip for the user. This will be

displayed when the cursor moves on the text which contains the Hyperlink.
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2.7 Drop Cap 

A drop cap (dropped capital) is a large capital letter at the beginning of a paragraph. The size 

of a drop cap is usually two or more lines. Mostly used in formatting the document for 

newspaper. 

# Steps to Insert Drop Cap 

 Select the first character of a paragraph.

 Click on the Insert Tab 

 Click on Drop Cap in the Text group 

 A drop down list will appear as shown below,

 Select the drop cap option from the above list

 The first letter of the selected paragraph will be displayed as a large capital letter as

shown below, AEES
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EXERCISES 

I. Short answer type questions.

1) Define Header and Footer option in MS-Word.

2) Define Mail Merge.

3) What are the three main steps for performing Mail Merge?

4) What is hyperlink?

5) What is the purpose of Drop Cap?

PRACTICAL EXERCISES 

1) The school is going to present a certificate to the students for the

achievements in Co-Curricular Activities. Create a Certificate using MS Word. 

In the Data Source enter the Student details such as Name, Class/Sec., Events in 

which the student got prize, position, etc., Using mail merge create certificates 

for all the students. 

2) i. Create a word document on the topic “Water scarcity and Importance of

drinking water”. (Note: Make two paragraphs, one for Water Scarcity and the 

other for Importance of Water) 

ii. In the Header add the text “Each drop counts” and in the footer add the

text “Save Water”. 

iii. Using page column make two columns. Let the contents of “Water

Scarcity” to be displayed in the first column and the contents of “Imporance of 

drinking water” to be displayed in the second column. 

iv. Use drop cap at the beginning of each paragraph.
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UNIT- III 

SPREAD SHEET (MS EXCEL) 

3.1 Table creation in MS Excel and implementing Various Charts 

A worksheet is a collection of cells, where data is entered and can be manipulated. 

# Creating a Table in MS Excel 

Table is a collection of related data arranged in rows and columns.  

Open Microsoft Office Excel. 

A workbook opens with 3 work sheets by default. 

Select the cells you want to include in the table. 

Click on Insert Tab 

Click on Table from Tables group 

A Create Table dialog box appears as shown below 
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Click on Ok button. 

Different Table styles are available in the Design Tab. 

Select the required Table Style. 

By default the field names will be shown as Column1, Column 2, etc., rename the Columns 

name as required for the table. 

Enter the data in the table, the sample table created is shown below, 

Table 3.1: Student mark list table created in MS excel 
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# Charts 

 Select the cells you want to chart, including the column titles and row labels.

These cells will be the source data for the chart. In the given example, Cells

B2:G8 is selected.

 Click on Insert Tab will appear as shown below,

 In the Chart group different types of chart will be displayed.

 Click on desired chart type from the Charts group. For example, Column

Chart has been chosen here.

 The chart appears as shown below,

Figure 3.1 A chart created for the table shown in 3.1 
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Parts of the Chart 

Figure 3.2: Components of a Chart in Excel 

 Chart Title: A chart title identifies the graph to the operator and is displayed at the

top of thegraph.

 Chart area: Everything inside the chart window, including all parts of the chart

(labels, axes, data markers, tick marks, and other elements listed here).

 Data series: A group of related values, such as all the values in a single row in the

chart. A chart can have just one data series (shown in a single bar or line), but it

usually has several.

 Axis: A line that serves as a major reference for plotting data in a chart. In two-

dimensional charts there are two axis

o x-axis (horizontal)

o y-axis (vertical).

 Plot area: The area where Excel plots the data, including the axis and all markers that

represent data points.
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 Grid lines: Optional lines extending from the tick marks across the plot area, thus

making it easier to view the data values represented by the tick marks.

 Legend: A key that identifies patterns, colors or symbols associated with the markers

of a chart data series. The legend shows the data series name corresponding to each

data marker (such as the name of the blue columns in a column chart).

 Chart label: A data label provides information about individual data markers, such as

the value being graphed either as a number or as a percent.

Types of Chart 

Excel provides you different types of charts. Based on the type of data, you can create a 

chart. You can also change the chart type later. 

Excel offers the following major chart types − 

 Column Chart

 Line Chart

 Pie Chart

 Doughnut Chart

 Bar Chart

 Area Chart

 XY (Scatter) Chart

 Bubble Chart

 Surface Chart

 Radar Chart

Each of these chart types have sub-types. 

Column Chart 

A Column Chart typically displays the categories along the horizontal (category) axis and 

values along the vertical (value) axis.  

Line Chart 

Line charts can show continuous data over time on an evenly scaled Axis. Therefore, they 

are ideal for showing trends in data at equal intervals, such as months, quarters or years. 

In a Line chart − 
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 Category data is distributed evenly along the horizontal axis.

 Value data is distributed evenly along the vertical axis.

Pie Chart 

Pie charts show the size of items in one data series, proportional to the sum of the items. The 

data points in a pie chart are shown as a percentage of the whole pie.  

Doughnut Chart 

A Doughnut chart shows the relationship of parts to a whole. It is similar to a Pie Chart with 

the only difference that a Doughnut Chart can contain more than one data series, whereas, a 

Pie Chart can contain only one data series. 

A Doughnut Chart contains rings and each ring representing one data series. 

Bar Chart 

Bar Charts illustrate comparisons among individual items. In a Bar Chart, the categories are 

organized along the vertical axis and the values are organized along the horizontal axis.  

Area Chart 

Area Charts can be used to plot the change over time and draw attention to the total value 

across a trend. By showing the sum of the plotted values, an area chart also shows the 

relationship of parts to a whole.  

XY (Scatter) Chart 

XY (Scatter) charts are typically used for showing and comparing numeric values, like 

scientific, statistical, and engineering data. 

A Scatter chart has two Value Axes − 

 Horizontal (x) Value Axis

 Vertical (y) Value Axis

It combines x and y values into single data points and displays them in irregular intervals, or 

clusters. To create a Scatter chart, arrange the data in columns and rows on the worksheet. 

Place the x values in one row or column, and then enter the corresponding y values in the 

adjacent rows or columns. 

Bubble Chart 

A Bubble chart is like a Scatter chart with an additional third column to specify the size of 

the bubbles it shows to represent the data points in the data series. 

A Bubble chart has the following sub-types − 
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 Bubble

 Bubble with 3-D effect

Surface Chart 

A Surface chart is useful when you want to find the optimum combinations between two sets 

of data. As in a topographic map, colors and patterns indicate areas that are in the same 

range of values. 

To create a Surface chart − 

 Ensure that both the categories and the data series are numeric values.

 Arrange the data in columns or rows on the worksheet.

Radar Chart 

Radar charts compare the aggregate values of several data series. 

3.2 Cell reference in MS Excel 

A cell reference refers to a cell or a range of cells on a worksheet and can be used in a 

formula so that Microsoft Office Excel can find the data that the formula has to calculate. 

Types of Cell reference 

There are three types: 

 Relative reference

 Absolute reference

 Mixed reference

The type of cell reference is important when writing a formula, since each behaves differently 

when copied or moved to another cell. 

Understanding Cell References 

Cell reference means the cell to which another cell refers. For instance, if in B2 you have 

=B3, cell B2 is referring to cell B3. The cell reference in this example is B3 

In the formula,  =sum(B2:B10), the cell reference is B2:B10. The formula is telling Excel to 

add all of the numbers starting in cell B2 through cell B10. Sometimes the cell reference may 

be referred to as the cell range because most references in a formula refer to multiple cells 

within a range. 
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Relative reference 

By default, Excel uses relative reference. .Relative cell references, when copied to another 

cell or across multiple cells, will change based on where you copy them. For example, Look 

at the excel sheet given below for calculating the area of a circle when radius is given. 

The formula for finding the area of a circle is   

So in the cell D3, the formula is given as =C3*B3*B3. 

In cells D4, D5, D6 and D7, formulas need not be typed again. Click on the cell D3, now D3 

is the active cell. Keep the cursor in the right bottom corner of the active cell a + symbol 

appears , hold and press the plus sign to copy the formula down. Automatically, the formulas 

in cells D4, D5, D6 and D7 will become =C4*B4*B4, =C5*B5*B5, =C6*B6*B6, and 

=C7*B7*B7. 

Absolute reference 

To make the cell reference to absolute cell reference, $ symbol has to be placed before the 

column alphabet and row number. 

Unlike relative references, absolute references do not change when copied and pasted in other 

cell. You can use an absolute reference to keep a row, column or both constant. For example, 

In the calculation of area of the circle , ∏ value remains constant. So instead of entering the 

value from cells C3 to C7, absolute reference can be used. 
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 Mixed reference 

A combination of relative and absolute reference is called mixed reference. In some 

applications we may need to keep the row as contant and column as changing. Then place a $ 

symbol in front of the row number (B$6) in the formula. 

3.3 Functions in MS Excel 

A function is a predefined formula that performs calculations using specific values in a 

particular order. Functions save the users time because they need not write the formula. For 

example, an Excel function called SUM can be used to quickly find the addition value of the 

values in a range of numbers. 

The parts of a function, 

1. All functions begin with the equal sign (=).

2. After the = sign, define the function name (e.g., Sum).

3. An argument is the cell range or cell references that are enclosed by parentheses.

An example of a function to add a range of cells, A3 through A9 is given below, 
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# Commonly used functions in Excel 

 Statistical functions

 SUM: Adds the values entered in the range of cells mentioned in the argument.

The syntax of the function is: 

=SUM( number1, number2, ... ) 

where the number arguments are a set of numbers that you want to find the sum of. 

Example : In table 3.1, enter =SUM(C2:C8) in the cell C9, the addition value of the 

numbers from cell C2 to C8 will be displayed.  This shows the total marks obtained in 

English by all the students. 

Figure 3.3: Screen shot of SUM function 

 AVERAGE: Calculates the average of a range of cells mentioned in the argument.

The syntax of the function is: 

=AVERAGE( number1, number2, ... ) 

Example : In table 3.1, enter =AVERAGE(D2:D8) in the cell D9, the average value 

of the numbers from cell D2 to D8 will be displayed.  This shows the average marks 

obtained in Hindi. 

Figure 3.4: Screen shot of AVERAGE function 
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 COUNT:  The COUNT function counts the number of cells that contain numbers,

and counts numbers within the list of arguments.

The syntax of the function is: 

=COUNT( number1, number2, ... ) 

Example : In table 3.1, enter =COUNT(E2:E8) in the cell E9, the numbers of entries  

made from cell E2 to E8 will be counted and displayed.  This can be used to find the 

number of studens attended the maths exam. (Assuming that no mark entries will be 

made for absentees). 

Figure 3.5: Screen shot of COUNT function 

 MAX: Identifies the largest number in a range of cells mentioned in the argument.

The syntax of the function is: 

=MAX( number1, number2, ...) 

Example : In table 3.1, enter =MAX(F2:F8) in the cell F9, the maximum value from 

cell F2 to F8 will be displayed.  This will display the the maximum marks obtained in 

Science. 

Figure 3.6: Screen shot of MAX function 
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 MIN: Identifies the smallest number in a range of cells mentioned in the argument.

The syntax of the function is: 

=MIN( number1, number2, ... ) 

Example : In table 3.1, enter =MIN(G2:G8) in the cell G9, the manimum marks 

obtained from cell G2 to G8 will be displayed.  This will display the the minimum 

marks obtained in Social Science. 

Figure 3.7: Screen shot of MIN function 

 Text functions

 CONCATENATE: Joins several text strings into one text string.

The syntax of the function is:

=CONCATENATE(text1,text2,...)

Example: Enter the following in a cell,

=CONCATENATE("Good", " ", "Morning")

The output will be displayed as Good Morning

 LENGTH: Returns the number of characters in a text string.

The syntax of the function is:

=LEN(text)

Example: Enter the following in a cell,

=LEN("Hello")

The output will be displayed as 5.

 LOWER : Converts all uppercase letters in a text string to lowercase.

The syntax of the function is:

=LOWER(text)

Example: Enter the following in a cell,
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=LOWER("HELLO") 

The output will be displayed as hello 

 UPPER: Converts all lowercase letters in a text string to uppercase.

The syntax of the function is:

=UPPER(text)

Example: Enter the following in a cell,

=LOWER("hello")

The output will be displayed as HELLO

 TRIM: Removes all spaces from text except for single spaces between words.

The syntax of the function is:

=TRIM(text)

Example: Enter the following in a cell,

=TRIM("Good     Morning")

The output will be displayed as Good Morning

 Date functions

 NOW: Returns the current date & time.

The syntax of the function is:

=NOW( )

The output will be 04-05-2018 16:20

 TODAY: Returns today's date.

The syntax of the function is:

=TODAY( )

The output will be 04-05-2018

3.4 Sorting of data in MS Excel 

Sorting allows to reorder the data in ascending or descending order. 

# Steps to sort in alphabetical order 

 Select a cell in the column you want to sort .

 Click the Sort & Filter command in the Editing group on the Home tab.

 Select Sort A to Z. Now the information in the Category column is organized in

alphabetical order.
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Sort Z to A option allows to sort the data in reverse alphabetical order. 

Example: In the table 3.1, Sorting the data based on Name of the students field. 

# Step to sort from smallest to largest number 

 Select a cell in the column you want to sort.

 Click the Sort & Filter command in the Editing group on the Home tab.

 Select From Smallest to Largest. The data will be organized from the smallest to

largest.

You can sort in reverse numerical order by choosing From Largest to Smallest in 

the list. 

Largest to Smallest option allows to sort data from largest to smallest number. 

3.5. Filtering data in MS Excel 

You can filter data using the AutoFilter feature in Excel 2007 to display only the data that 

meets specified criteria. Filtered data can be copied, manipulated, and printed without having 

to move it to a new spreadsheet. 

Data can be filtered to get specific value based on a specific crieteria. 
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# Steps to Filter the data in excel 

 Select the Data tab, then select Sort & Filter in Editing group.

 Click on Filter from the drop down menu.

 Drop-down arrows will appear in the header of each column.

 Click the drop-down arrow for the column you want to filter. In this example, 
we'll filter the English marks column to filter the students detail who scored 40.

 The Filter menu appears.

 Uncheck the boxes next to the data you don't want to view, or uncheck the box 
next to Select All to quickly uncheck all.

 Check the boxes next to the data that you want to filter. In this example, we'll 
check 40. (As shown in the Figure 3.8.) 

Figure 3.8: Screen shot of Number filters 

 Click OK. All other data will be filtered, or temporarily hidden. Only the data

of the students, who scored 40 in English subject  will be visible.

Figure 3.9: Screen shot of Filtered table 

Note: To remove the filtering and view all the data again click on the filter in the Editing 

group. 
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3.6. Conditional Formatting MS Excel 

Conditional formatting is used to format cells according to a particular condition. 

# Steps for Conditional formatting in Excel 

 Select the range of cells to which you want to apply conditional formatting.

 Click the Conditional Formatting button in the Styles group on the Home tab.

 A menu appears as shown below, with several different options for specifying the

criteria.



 Point to Highlight Cells Rules and then select the criteria you want to use. (Criteria 

options include Greater Than, Less Than, Between, Equal To, Text That Contains, A 

Date Occurring, and Duplicate Values). 

 A dialog box opens, where you can specify the value.

 Enter the values you want to reference in the text box.

 Click the drop-down arrow next to the format options and select the desired

formatting.

 Live Preview shows you what your data will look like. Click the Custom Format

option if you want to create your own formatting selections.

 Click OK. The cells that meet the specified criteria now appear with the chosen

formatting options.

Example : In the table 3.1, the cells with 40 marks are highlighted.
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3.7 Workbook & Worksheet 

# Workbook 

 The workbook is a collection of worksheets.

 When a new excel file is created, a new workbook opens.

 By default the workbook consists of three worksheets.

 More Worksheets can be added to the workbook.

 A worksheet can also be deleted from the workbook.

 A worksheet organizes various kinds of related information.

Figure 5.1: A workbook 

# Worksheet 

 A worksheet is a collection of cells, where data is entered and can be manipulated.

 A cell is an intersection of a row and a column.

 Rows are named with Arabic numbers.

 Columns are named with Alphabets.

 A cell is named as a combination of intersecting column name and row name

respectively. Example: A1
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Figure 5.2: A worksheet 

 An active cell is a cell which is currently selected. It will be highlighted by a

rectangular box and its name will be shown in the name box. In the figure 5.2 A1 is

the active cell.

3.8 Protection of Work book and Worksheet 

Workbook can be protected with a Password. This will restrict access to the workbook by 

preventing  new sheets from being created or by granting access only to specific people. 

# Steps to protect the workbook 

 Click on the Review menu.

 Click on Protect Workbook in the Changes group.

 The drop down menu appears as shown below,
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 Click on Protect Structure and Windows option to prevent unwanted changes to the

structure of the workbook, such as moving, deleting or adding sheets.

 A dialog box appears as shown below,

 Type the password and Click on OK button

# Steps to protect the worksheet 

 Click on the Review menu.

 Click on Protect Worksheet in the Changes

group.

 The Protect Sheet dialog box appears,

 Type the Password to unprotect sheet.

 Click on OK button. AEES
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EXERCISES 

I. Fill in the blanks.

1) ___________ function in Excel returns the current date & time.

2) In Excel , a fucntion or formula always starts with _________ symbol.

3) _________ symbol is used to create absolute reference.

4) ____________ and ____________ charts are round / circular in shape.

5) By default, a work book consists of _______________ number of 
work sheets.

II. Short answer type questions.

1) Explain different components of chart with help of a neat diagram.

2) What are the different types of cell reference in MS-Excel?

3) Explain different Statistical functions avaliable in MS-Excel. 

4) Explain different Text functions avaliable in MS-Excel.

5) Define Sorting. Write the steps to sort the data in MS-Excel.

6) What do you mean by a function in Excel. Explain with one example.

How it is different from a formula?

PRACTICAL EXERCISES 

1) i. Create a table in a new workbook in MS Excel for Cricket Score

Board. (With the fields S. No., Name, Runs/Score, Strike rate, No. of Sixes, No. 

of Fours and No. of Vickets taken). 

ii. Sort the data based on the Alphabetical order (A to Z) of Name of

the Player. 

iii. Filter the records of the players who scored sixers.

iv. Highlight the cells in the run column where the score is less than 10

using conditional formatting. 

2) Create any type of chart for the table “Cricket Score Board”.
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